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Volume 22    Number 4              The Dalles, Oregon                  October 2008 
 
   THANKS to our members Sandy and Jim 
Bisset, Helen and Ray Dixon, Earline Wasser, 
Renee Briggs, and Karen Polehn for spending 
Saturday, September 20th. and Historic The 
Dalles Days at The Dalles Pioneer Cemetery 
showcasing our organization and acquainting 
participants with the cemetery.   

             
  
 Also, thanks to City of The Dalles, 
particularly Dawn Hert and the 
Historic Landmarks Commission, 
we have a forty inch square map of 
the cemetery, which was mounted 
at the expense of another 
benefactor.  
  
    We had a small crowd at the 
cemetery but had some interesting 
conversations. Social Studies 
Teacher, Paulette Brook of The 
Dalles Wahtonka H.S., and 
students Celene Maldonado, and 
Chelsea Menzie-Hughes  came 
and learned the history of some of 
the interred.  Paulette plans to have 
her students involved in the spring 
clean up in 2009.  We will resume 
our involvement also. 
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SOCIETY SURNAME LIST 
The surname list is compiled by Surname, Date, Place of 
Birth and Death of ancestors done on a pedigree chart 

and turned into Rose Denslinger, 541-296-
4140. If you need blank pedigree charts to 
fill out, contact Rose.  

   denslinger@gorge.net 
 

When submitting your pedigree chart, there 
should be a year(s) and an area (county and state) 
associated with the surname. If these are unknown when 
you submit a pedigree chart, we count back 20 years 
from the birth of the first descendent. That date will be 
used with a question mark. The same area as the birth of 
the first child will be used for the area. 
 
The compiled Surname Lists are on the shelves of the 
Genealogy cases in The Dalles/Wasco County Public 
Library. New charts will be filed in the Additions 
Section.  
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PRESIDENT’S MESSAGE 

 

    We have had a busy year, and continue to do so.  
Every month brings new members and new ideas.  Our 
recent activities are covered elsewhere in this issue, as 
are the upcoming programs.  I just want to thank all of 
you who have been active in the organization this year, 
and hope that more of you are able to help share the 
work load this next year.  Currently we are in need of a 
membership chair person and a publications chair 
person. These are both positions that will take a fair 
amount of time and are necessary to the effective 
functioning of our organization.  I have written out my 
ideas for what is involved.  Give me a call or an email 
and let’s talk about it.  Keep in mind that both can be 
accomplished from anywhere.   By the time the next 
newsletter comes out it will be 2009.  Remember our 
book list when you do your Christmas shopping and 
have a great research season.  
                                                                     Sandy Bisset   

 

Welcome New Member 
                               Opal Myhres 
 

Summer Program 
THANKS to Mary Watts, Teddy Parkinson, Jenny 
Garner, Helen Dixon, Gerry Stephens, Bob Long, and Jo 
Ann Hardin, who took part in our July 
workshop at the Picture Patch.   They 
were enthusiastic participants in this 
day long, hands on workshop 
showing how to incorporate family 
stories, heirlooms, and other non-
traditional items into their family histories.  My 
apologies for having to cancel the August workshop on 
archival storage.   
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RESOURCE  CENTERS 
 

The Dalles-Wasco County Library 
c/o Lorna Elliott 
722 Court Street 
The Dalles, OR 97058 
Phone: 541-296-2815 
Hours: 
Tuesday & Wednesday: 11 a.m. to 8:30 p.m. 
Thursday & Friday: 10 a.m. to 6 p.m. 
Saturday: 10 a.m. to 3 p.m. 
Sunday & Monday: Closed 

  

                      
The Family History Centers 
 
The Dalles FHC 
1504 East 15th Street 
The Dalles, OR 97058 
West Entrance, basement 
Phone: 541-298-5815 Director: Chris Knowland 
Hours: 
Tuesday, Wed., Thursday:  10 a.m. to 8:30 p.m. 
.  
Goldendale FHC 
North Columbus Avenue, & McKinley 
c/o Ed Hoyle 
P.O. Box 109 
Goldendale, WA 98620 
Phone: 509-773-3824 
Hours: 
Tuesday, Wednesday  10:00 a.m. to 4:00 p.m. 
Thursday Only:  6:00 p.m. to 9:00 p.m. 
  
Hood River FHC 
18th and May, Hood River, OR 
c/o Noretta Hornbeck 
Phone: 541-386-3539 
Hours: 
Tuesday, Wed., Thursday: 10:00 a.m.to 8:30 p.m. 
  
Stevenson FHC 
Maple Way and Loop Rd., Stevenson, WA 
c/o Emerline Andrews 
Phone: 509-427-5927 
Hours: 
Wednesday: 1:00 p.m. to 3:00 p.m. 
Thursday: 6:00 p.m. to 9:00 p.m. 

William G. Dick Library 
The Discovery Center & Wasco County 
Historical Museum 
  
5000 Discovery Road 
The Dalles, OR 97058 
 
Phone: 541-296-8600, x. 219 
Hours: M-W-F: 11 to 3, and by appointment 
E-mail: library@gorgediscovery.org 
 
Dufur Historical Society 
P.O. Box 462 
Dufur, OR 97021 
DufurHist@ortelco.net 
  
Maupin Library            
P.O. Box 328 
Maupin, OR 97037 
541-395-2208 
SWCLibrary@centurytel.net 
  
Wamic Community Historical Society 
P.O. Box 806 
Wamic, OR 97063 
 
 
Returned Check Policy 
  
In the unfortunate event that a check that was written to the 
Columbia Gorge Genealogical Society for any reason, is 
returned unpaid by a bank then the Columbia Gorge 
Genealogical Society will use all mean necessary to collect 
payment of the check. A $20.00 returned check fee will be 
charged for each item returned from a bank regardless of the 
reason it was returned. This fee will be charged each time that 
an item is returned. 
  
Checks returned for non-sufficient funds or uncollected funds 
will be represented to the bank after we receive it. Checks 
returned because of stopped payment, account closed, or refer to 
maker can NOT be re-deposited. The amount of the check plus 
any applicable returned check fees will become immediately due 
and payable by the account holder. 
  
Any returned check item that is not paid promptly will be 
referred to a collection agency for further action. Returned check 
items must be paid in cash or cashier’s check. The Columbia 
Gorge Genealogical Society will not accept a personal check to 
pay returned check items (this includes returned check fees). 
  
Those who have any questions regarding returned checks or 
have had a check returned to the Society are encouraged to 
contact us as soon as possible.    (Telephone:  509-767-2316) 
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NEW RESOURCE AVAILABLE FOR LOCAL RESEARCHERS 
 

The Pioneer Cemetery - The Dalles, Oregon - 1860- 
Compiled and assembled by Earline Wasser 

Published by Columbia Gorge Genealogical Society, 2007 
 

In this volume, Earline Wasser has taken a century of 
research by Lulu Crandall, George Brown, Daphne Hon 
Ramsey, Lottie LeGett Gurley, Cheryl Gates, Anita 
Drake, and Lorna Elliott, combined it with many hours 
of research in the vaults at The Dalles Chronicle, to 
provide a definitive (as we know it at this point) and 
highly annotated list of burials in this cemetery located 
just below Columbia Gorge Community College on East 
Scenic Drive in The Dalles.  It contains a complete 
bibliography. 
 
Wasser also outlines over ten years of work by The 
Dalles Historic Landmarks Commission, Columbia 
Gorge Genealogical Society, archeologists Eric Gleason 
and Jacqueline Cheung, The Dalles Wahtonka 
Anthropology class under the direction of Gerald Iken, 
and other volunteers who cleared brush, located graves, 
and mapped their locations using global positioning 
technology.  An interesting section quotes newspaper 
articles as early as 1880 lamenting the condition of the 
cemetery.  Thanks to the diligence of volunteers and the 
hard work of Historic Landmarks staff member Dawn 

Hert and commission member Bob McNary, the 
cemetery has been cleared of brush, a new fence has 
been built, paths and gateways lead through the cemetery 
from Scenic Drive to the college entrance, and a wrought 
iron entrance gateway is in the planning stages.  The 
cemetery is rapidly becoming an asset to the 
neighborhood. 
 
The book is divided into the following sections: 
* Cemetery deed and selected newspaper articles 1880-
2005 
* Photos of selected markers 
* Individuals listed 
* Obituary and other information for those interred 
* Sources 
* Alphabetical Index 
 
The Pioneer Cemetery, The Dalles Oregon, 1860- sells 
for $20.00 a copy with a postage charge if applicable.  It 
is available through Columbia Gorge Genealogical 
Society.  An order form can be accessed through their 
website at http://community.gorge.net/genealogy, by 
emailing wildflowers@gorge.net with the subject line 
PIONEER CEMETERY, or by mailing a request to 
Columbia Gorge Genealogical Society c/o The 
Dalles/Wasco County Library, 722 Court Street, The 
Dalles, Oregon 97058.   
 
Fire, weather, vandalism, and time have taken a toll on 
the identification of the graves in The Dalles Pioneer 
Cemetery.  Columbia Gorge Genealogical Society has 
collected over four thousand dollars in contributions 
toward a granite monument, to be placed in the 
cemetery, listing the names of everyone buried there. All 
profits from the sale of this book will go toward 
purchase of the monument.  If you have questions 
contact Sandy Bisset at 541-298-1240 or 
wildflowers@gorge.net. 
 
 
Thanks to our member Dennis Radford and 
his employees for refurbishing the inside of 
the picket fence at The Dalles Pioneer 
Cemetery.  Under the guidance of Bob 
McNary of the Historic Landmarks 
Commission, shrubs were cut back to 
expose the fence, hours of scraping the old 
paint was done, and finally the fence was 
primed and painted.  It looks great. 
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Gordon Livingston Challenge 

 
     This past month we wound up nearly a year of research 
that began with an unusual discovery.  A local gunsmith 
had purchased a box of very old gun parts which included 
a shotgun stock.  When the butt plate was removed a well 
folded 1928 California juvenile hunting license fell out.  I 
challenged our members to take this challenge as a 
research exercise. 
     We devoted part of one meeting to figuring out 
strategy, then Mary Davis, Penny Kennedy, and yours 
truly took it from there.  With only a child’s name, the 
name of a town, and date of birth we found birth, death, 
marriage, military, and voting records. 
    The search took us to Washington as well as California.  
We identified his parents, his siblings, and the surnames 
of all four family lines in the previous generation.   
   We discovered that he was a United States Marine in 
World War II, and although we did not access the details, 
we found that he had been wounded in the war.  
     He seemingly never married, but we traced the 
marriages of both his sisters, including the birth of twin 
nephews.   
     Penny had great success with volunteers from the 
Random Acts of Genealogical Kindness program who 
went the extra mile in finding newspaper obituaries and 
mortuary records.  When the results were presented at the 
last society meeting there were twenty six names on the 
chart.  
   The project was handed off to Linda Colton to pursue 
with her volunteers at the Family History Center in Hood 
River.  Why did we do it, and what will we do with the 
information?  It was a challenge, good research practice, 
and fun.  It was the same thing those who research for 
strangers do regularly.   
   When Linda’s crew goes as far as they can we will turn 
the research packet over to the Fresno County 
Genealogical Society or if we are lucky enough to find a 
living relative, to the Livingston Family. 

 

Find A Grave 
Find the graves of ancestors, create virtual memorials by 
adding your loved one’s burial records, add 'virtual 
flowers' and a note to a loved one's grave. 
                        http://www.findagrave.com/  

Oregon Trail Project   (Correction) 
    In the last issue I told you about the certificates that 
were available to the descendants of the pioneers who 
migrated west on the Oregon Trail between 1811 and 
1911. The information given was incorrect and has been 
updated.  To qualify, you must be a descendent of anyone 
who traveled any part of the Oregon Trail. Information 
may be requested by sending a SASE to the Oregon Trial 
Project, Idaho Genealogical Society, PO Box 1854, Boise 
ID 83701-1854. or by a downloadable application online 
at  http://www.idahogenealogy.org 
 

Roberts Family of Dutch Flat 
 

   Andrew & Melinda Susan 'Susie' (Turnbull) 
Roberts were married in Brush Prairie, Clark, 
Washington on 30 Sep 1886. They had three children.  
Minerva Talitha Roberts was born on 28 Nov 1895. 
Dewey David Roberts was born 4 Aug 1898, and Andrew 
Morrison Roberts, Jr. was born 27 Sep 1900.  
   In 1904 this family moved to The Dalles, Wasco, OR. 
Susie was in poor health and her doctor had advised the 
move. They bought a ranch with a log home on Dutch Flat 
from a Mr. Nelson.  It was a stock & wheat farm. Andrew 
and Susie Roberts farmed this property until his death.  
    Minerva first married Phillip Arthur Wetmore and later 
married John Henry Denslinger, Sr.  After the death of 
Minerva’s father Andrew, John and Minerva, and their 
family moved from their farm on Upper Five Mile Creek 
to the Dutch Flat farm and Mr. Denslinger farmed both 
places.     Minerva died 25 May 1993 in The Dalles. John 
was born 18 March 1891 Crown Clarion, PA and died 11 
June 1967 in The Dalles.  Both are buried at Park Lawn 
Cemetery on Steel Road in The Dalles. 

Photo 
Taken at 

Vancouver, 
Clark Co. 
WA about 

1902 
 
Dewey  
Died 31 
Mar 1910  
The Dalles, 
Wasco, OR  
Buried  
IOOF  
Cemetery. 
Andrew 
Morrison 
Roberts, 
Jr.  Died 17 
Jan 1979 in 
Spokane, 
A.  

 
 
 

Submitted by Rose Denslinger 
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Fifty Questions for Family History Interviews 
By Kimberly Powell, 

 
A great way to uncover clues to 
your family history or to get 
great quotes for journaling in 
a heritage scrapbook is a 
family interview. By asking 
the right, open-ended questions, you're sure to collect a 
wealth of family tales. Use this list of family history 
interview questions to help you get started but be sure to 
personalize the interview with your own questions as well. 
 
   1. What is your full name? Why did your parents select 
this name for you? Did you have a nickname? 
   2. When and where were you born? 
   3. How did your family come to live there? 
   4. Were there other family members in the area? Who? 
   5. What was the house like? How many rooms? 
Bathrooms? Electricity? Indoor plumbing? Telephones? 
   6. Were there any special items in the house that you 
remember? 
   7. What is your earliest childhood memory? 
   8. Describe the personalities of your family members. 
   9. What kind of games did you play growing up? 
  10. What was your favorite toy and why? 
  11. What was your favorite thing to do for fun (movies, 
beach, etc.)? 
  12. Did you have family chores? What were they? Which 
was your least favorite? 
  13. Did you receive an allowance? How much? Did you 
save your money or spend it? 
  14. What was school like for you as a child? What were 
your best and worst subjects? Where did you attend grade 
school? High school? College? 
  15. What school activities and sports did you participate 
in? 
  16. Do you remember any fads from your youth? Popular 
hairstyles? Clothes? 
  17. Who were your childhood heroes? 
  18. What were your favorite songs and music? 
  19. Did you have any pets? If so, what kind and what 
were their names? 
  20. What was your religion growing up? What church, if 
any, did you attend? 
  21. Were you ever mentioned in a newspaper? 
  22. Who were your friends when you were growing up? 
  23. What world events had the most impact on you while 
you were growing up? Did any of them personally affect 
your family? 
  24. Describe a typical family dinner. 
  25. How were holidays (birthdays, Christmas, etc.) 
celebrated in your family? Did your family have special 
traditions? 
 

  26. How is the world today different from what it was 
like when you were a child? 
  27. Who was the oldest relative you remember as a 
child? What do you remember about them? 
  28. What do you know about your family surname? 
  29. Is there a naming tradition in your family, such as 
always giving the firstborn son the name of his paternal 
grandfather? 
  30. What stories have come down to you about your 
parents? Grandparents? More distant ancestors? 
  31. Are there any stories about famous or infamous 
relatives in your family? 
  32. Have any recipes been passed down to you from 
family members? 
  33. Are there any physical characteristics that run in your 
family? 
  34. Are there any special heirlooms, photos, bibles or 
other memorabilia that have been passed down in your 
family? 
  35. What was the full name of your spouse? Siblings? 
Parents? 
  36. When and how did you meet your spouse? What did 
you do on dates? 
  37. What was it like when you proposed (or were 
proposed to)? Where and when did it happen? How did 
you feel? 
  38. Where and when did you get married? 
  39. What memory stands out the most from your 
wedding day? 
  40. How would you describe your spouse? What do (did) 
you admire most about them? 
  41. What do you believe is the key to a successful 
marriage? 
  42. How did you find out you were going to be a parent 
for the first time? 
  43. Why did you choose your children's names? 
  44. What was your proudest moment as a parent? 
  45. What did your family enjoy doing together? 
  46. What was your profession and how did you choose 
it? 
  47. If you could have had any other profession what 
would it have been? Why wasn't it your first choice? 
  48. Of all the things you learned from your parents, 
which do you feel was the most valuable? 
  49. What accomplishments were you the most proud of? 
  50. What is the one thing you most want people to 
remember about you? 
 
      You could also interview yourself.  Answer these 
questions, and pass along to your children and 
grandchildren
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Puzzling Discovery 
 

   Recently a military tombstone (photo below) was found 
in the basement of the old American Legion Building on 
Main Street in Goldendale.  It was in its original crate with 
the message “Deliver to IOOF Cemetery, Goldendale, 
Washington.”   It has the following inscription: 
Christopher Ward Q-M SGT. Co. L 15 KANS CAV, which 
translates Quartermaster Sergeant, Company L, 15th 
Kansas Cavalry.  It has no dates listed.  Preliminary 
research indicates this unit was called up in response to 
the burning of Lawrence, Kansas by William Quantrill’s 
Raiders in 1863.  Ward came to Klickitat County in the 
1880’s and his family lived at Goldendale and Cleveland 
and may still be there.  Ward died in 1913 and is buried in 
the Goldendale IOOF Cemetery and has a tombstone.  Can 
you help us sort this out.  Please send information to Kris 
Rising of Pioneer Monument at rising@gorge.net  or 
Sandy Bisset at wildflowers@gorge.net 

Photo by Sandy Bisset 
 

About Dates 
Birth/death year dates such as March 5, 1623/24 offer both 
the Old (Julian) Calendar year date and the New 
(Gregorian) Calendar year date in use today. These 
double-year dates occur mostly for the months of January 
through March. The New Calendar was adopted by Great 
Britain and its colonies in 1752, when eleven days were 
added to that year to bring the calendar in line with the 
solar year. 

What’s in A Name 
 

According to Oregon Geographic Names, 6th Edition by 
Lewis L. McArthur, p.594 
The name The Dalles is derived from the French word 
dalle, meaning flagstone, and was applied to the narrows 
of the Columbia River, above the present city of The 
Dalles, by French-Canadian employees of the fur 
companies. Among other things, dalle meant a stone used 
to flag gutters, and the peculiar basalt formations along the 
narrows doubtless suggested gutters. The word dalles 
signified to the voyageurs, the river rapids flowing swiftly 
through a narrow channel over flat, basaltic rocks. The 
first use of the name Dalles in Oregon was in 1814. The 
name La Grande Dalle de la Columbia became 
established. Although the city is officially Dalles City, the 
post office, and common usage is The Dalles. It has had 
several names since incorporation: Dalles, 1851; 
Wascopum, 1853; The Dalles, 1860. The Indians in the 
area called the area near Mill Creek, in present day The 
Dalles, Quenett, which was also their word for trout. 
Lewis and Clark camped here in 1806 and named it 
Rockfort Camp. Another Indian name in use was Win-
quatt, signifying a place encircled by rock cliffs. 

 

We Get Letters 

Hi Sandy, 
 
      Your fascinating Occasional 
Genealogical E-Letter arrived in 
yesterday's mail and I was surprised to 
find my email address listed among the 
missing (I'm the Elizabeth in Newport). Anyway, I learned 
a lot about what's going on with CGGS and really 
appreciate having received a copy of it. Thanks. Being a 
Hood River native (I grew up in Pine Grove and Joni 
Walker was one of my earliest playmates), it will be great 
to be able to keep up with what's going on via email now. 
         
     One way I try to stay in contact with my roots is by 
hosting Oregon GenWeb's Hood River County page at 
http://www.rootsweb.ancestry.com/~orhoodri/ I also 
maintain the Rootsweb Hood River County mailing list 
and message board. Earline Wasser has been a terrific 
contributor to the HR mailing list with her transcriptions 
of past Wasco and HR counties items. Now that I've put 
down some roots in Newport (28 years now!) I do the 
same for Lincoln County, plus serve as webmaster and 
newsletter editor for the Lincoln County Genealogical 
Society. http://www.rootsweb.ancestry.com/~orygs/  
       
  Enough for now.  Thanks again for sending the E-Letter.                                   

                                                            
      Beth Johnson 
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Newspaper History in The Dalles   
The following information was published in The Dalles Chronicle, July 7, 1950. 

     
The Dalles was the first town 
between the Missouri and the 
Columbia rivers to have a 

newspaper. April 1, 1859 was the 
date of issue number one of the first 

paper here, The Dalles Journal. It 
was published in the garrison at Ft. Dalles. 

     The Mountaineer became a daily paper in 1862 but 
reverted to a weekly four years later. By 1881, the paper had 
gone through the hands of two more owners 
and in that year was finally acquired by Co. T.S. Lang. In 
1880, The Dalles Times had been established, and the two 
publications were consolidated in 1882 to become The 
Times-Mountaineer. This was a nine-column paper, at first 
published as an afternoon edition, and later as a morning 
sheet. 
      The year 1900 saw the Times-Mountaineeer become a 
weekly, then a semi-weekly in 1901. In 1904, the owner, J.A. 
Douthit, retired, and the newspaper which had served The 
Dalles for more than 40 years died. In 1860, The Dalles had a 
paper called The Weekly, but it lasted only a short time. 
Another, The Daily Journal, was born in 1883 and died two 
years later. The Dalles Tribune came in about 1875, and it 
lasted only two years.  
      The Inland Empire was next on the scene, in 1876, but 
passed on in 1880. The Wasco Weekly Sun was created on 
July 4, 1881. The paper was incorporated under the name of 
The Dalles Publishing company six years later. The Sun 
continued to be published regularly until the flood of 1884 
and was called The Oregon Democrat-Journal. It lasted for 
about one and a half years 
      But in 1890 another paper had come on the scene. It was 
one of many papers which lasted from four weeks to 40 
years. This new one was a daily. No one knew how long it 
would last, although its stockholders naturally hoped it 
would grow to huge proportions.  
     This new paper was named The Dalles Chronicle.  
     The first editor of The Chronicle was described as a 
bright, energetic young man, named J.H. Cradlebaugh. In its 
Dec. 15, 1915 25th birthday edition, The Chronicle said that 
"today he is one of the best known newspapermen in the 
Northwest."  
      A list of stockholders of The Chronicle shows the now 
famous names of D.M. French, Robert Mays, J.W. French, 
B.F. Laughlin, Wintworth Lord, I.C. Nickelson, Maxmillian 
Vogt, Hugh Glenn, S.L. Brooks, C.L. Phillips and A.S. 
McAllister.  
     The corporation was The Chronicle Publishing Company.  
     In 1907, a new man joined the staff of The Chronicle as a 
printer - he stayed for a number of years. His name was Ben. 
R. Litfin and he came here from Clearwater, Minn.  
     Manager of the paper by 1907 was H.G. Miller.  
     The next year, The Chronicle was changed to a morning 
paper and Litfin was appointed foreman in the composing 

room.  
     The paper returned to being an evening publication in 
about one month.  
     That same year, 1908, stockholders gave Manager Miller 
an option to buy stock. He and Litfin picked up what stock 
they could while the options were good. In 1909, Miller and 
Litfin bought the remaining stock and, with Editor, H.T. 
Hopins, became sole owners to The Chronicle Publishing 
company. 
     This partnership lasted for three years, until, in 1912, 
Hopkins sold his interest and withdrew from the company. 
Clarence Hedges, of Salinas, Calif., came on the scene and 
purchased all stock from Miller and Litfin, Miller left the 
field and is retired in The Dalles today, but Litfin stayed on 
as business manager 
     May 2, 1920 was the date for the next shakeup. Litfin and 
W.P. Mary of Detroit bought out Hedges. Litfin became 
publisher, a position he retained until his retirement in 1947. 
      Three years later, Litfin bought Mary’s stock and became 
owner of The Chronicle by himself.  
     On Jan. 1, 1923, the size of The Chronicle was changed. It 
had been six columns by 20 inches, but another inch was 
added to the length and it became a seven-column paper. 
This page size underwent another change in 1927, when it 
took its present shape, eight columns by 21 inches.  
      Fire in 1946 eventually moved The Chronicle to its new 
building, but only after months of patient location in make-
shift quarters.  
      In 1947, Litfin sold the paper and retired. It went to 
Victor Morgan of Clearwater, Fla., who quickly put into 
action a modernization plan. A Sunday morning paper was 
published instead of a Saturday evening edition, and extra 
comics and features were added to make the overall paper 
larger on Sunday.  
      Then in January 1948, the new Chronicle's building 
opened - a modern plant with adequate engraving and 
stereotyping shops. In December 1948, Morgan sold his 
interests in the paper to Robert S. Howard. Howard sold part 
interest to the Scripps league in the summer of 1949. The 
ownership [resided] in the Western Publishing Company, 
under the management of George R. Skaugset, publisher. 
      
     The Dalles Chronicle printed its first edition in December 
1890 on the northwest corner of East Second and Union. 
There was a print shop on that corner then; today it’s the site 
of the Granada Theatre, but distant though it is in time, it’s 
quite close in another sense: the Chronicle’s original home is 
only a block from its new location at 315 E. Federal St. in 
The Dalles, Oregon. 
 
 

Reprinted with permission from The Dalles Chronicle 
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ON THE WEB 
 

Citizenship & Immigration 
 Genealogy Program  

 
   Customers can now turn to U.S. Citizenship and 
Immigration Services (USCIS) for help in researching 
their family’s immigration history through the agency’s 
new Genealogy Program. 
   USCIS maintains historical records documenting the 
arrival and naturalization of millions of immigrants who 
arrived in the United States since the late 1800s and/or 
naturalized between 1906 and 1956.  
Until today, the process to request these records was 
handled through a Freedom of Information Act / Privacy 
Act (FOIA) request. 
    “In many cases USCIS is the only government agency 
that has certain historical records that provide the missing 
link [that] genealogists or family historians need,” said 
Jonathan “Jock” Scharfen, USCIS’ Acting Director. 
    The agency anticipates interest in genealogy to continue 
to grow. In the past four years alone, USCIS received 
more than 40,000 FOIA requests for historical records. 
The new genealogy program will create a dedicated queue 
for genealogists, historians and others seeking 
genealogical and historical records and reference services 
that generally require no FOIA expertise. As a result, 
USCIS will provide more timely responses to requests for 
records of deceased individuals. 
    Individuals may submit genealogy records requests by 
using the new forms, G-1041 - Genealogy Index Search 
Request, and G-1041A - Genealogy Records Request. 
Both forms are available on the new USCIS Genealogy 
Program page at: http://www.uscis.gov/genealogy.  
  
The fees include: 
Genealogy Index Search - $20 
Copy of a File on Microfilm - $20 
Copy of a Textual File Copy - $35 

 
 
 

Research Websites 
 

Civil War Records 
http://www.archives.gov/genealogy/military/civil-war/  
National Archives www.archives.gov  
Cyndi's List www.cyndislist.com  
Ancestry www.ancestry.com  
Rootsweb   www.rootsweb.com 
Washington State Digital Archives  
http://www.digitalarchives.wa.gov/TitleInfo.aspx?TID
=472  
Oregon Death Index: 
 http://www.deathindexes.com/oregon/index.html  
Social Security Death Index: 
 http://ssdi.rootsweb.ancestry.com/cgi-bin/ssdi.cgi  

 
Saving Web Page Text  

and Creating Screenshots 
                        By Mary Harrell-Sesniak 
 
    When copying information from a website, you may 
want only the text. To avoid copying images and other 
unwanted items, save it as a text file.  

1. Open the Web page you want to copy text from 
and select File>Save As.  

2. Select Plain Text (*.txt) in the Save as type field.  
3. Create a file name and click Save.  

    An alternate method is to copy and paste the 
information directly into a word processing or genealogy 
program as unformatted text. 

1. In the Web page, highlight the text with your 
mouse and copy it. (Press Ctrl+V; select 
File>Copy; or right-click the highlighted text and 
select Copy.)  

2. Open your word processing program or other 
program where you want to paste the text.  

3. Go to the Edit menu and select Paste 
Special>Unformatted Text, or a similarly 
worded option.  

     Ever wish you could take a snapshot of a reference or 
other item on the Web? It's not hard and is useful for 
documenting genealogy sources. Use the print screen 
option to take a "picture" and paste it into any program 
that accepts images—all graphics programs and most 
word processing programs. 

1. Verify that the item you are copying is not 
copyrighted or that it falls under fair use rules.  

2. Find the Print Screen button on your keyboard 
and press it. (Look at the top row on the right 
hand side.)  

3. Open the software where you will be pasting the 
image. Position the cursor in an appropriate place 
and paste the image. (The paste option is usually 
available as an icon, or it is located under the Edit 
menu. You may also be able to right-click your 
mouse and select Paste. )  

4. Document the screenshot by indicating where and 
when you found the image, as well as who the 
author of any information in the image is.  

5. Save the document in your usual manner.  
 

Reprinted with permission from Rootsweb 
Submitted by Rose Denslinger 

 
Sherman County Research 
http://genforum.genealogy.com/or/sherman/  
 
http://www.rootsweb.ancestry.com/~orsherma/  
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                    Ice Age Exhibition 
 

    The Columbia Gorge Discovery Center 
opened its new Ice Age Phase II Exhibition 
in June, featuring a life-size 13-foot 
Columbian mammoth and interpretation of 
the role that the Ice Age played in peopling 
the Americas.   

     The gorge is particularly linked to the Ice Age because 
of the role the Ice Age floods played in its creation. As 
legislators in Montana, Idaho, Washington, and Oregon 
seek designation of the Ice Age Floods National Geologic 
Trail, the region is drawing more interest from tourists 
wanting to find the touchstones of this dramatic period in 
the natural history of the Mid Columbia area. The exhibit 
is designed to spark interest and entice further exploration 
of the region.  The Ice Age Exhibit will be on display for 
many years. 
     For more information, visit the website at 
www.gorgediscovery.org or call (541) 296-8600. Open 
daily from 9 a.m. to 5 p.m.  
 

 
Oregon Historical Society Exhibit 

Carleton Watkins's Stereo views 
 of the Columbia River Gorge 

October 4, 2008 - January 11, 2009 
 

 Carleton Watkins is considered to be one of the finest 
landscape photographers of the early American West, and 
during a series of trips from 1867 to 1885, he 
photographed Portland and the Columbia River Gorge, 
capturing some of the first photographs of iconic 
landmarks such as Castle Rock, Cape Horn, and 
Multnomah Falls, as well as life, work, and transportation 
along the river. The Oregon Historical Society’s collection 
contains the most comprehensive set of Watkins’ images 
of Oregon ever to be assembled by an institution. The 
Oregon History Museum will display nearly one hundred 
photographs of the Columbia River Gorge that Watkins 
printed in the popular, nineteenth-century stereoscopic 
format – two identical photos mounted together that, when 
viewed through a special lens, make the image become 
three-dimensional. The OHS exhibit will allow visitors the 
unique chance to view these images as they were meant to 
be seen in “3D,” letting the viewer experience the 
formidable landscape of the Columbia River Gorge just as 
Carleton Watkins first experienced it 140 years ago. 

For more information visit:    http://www.ohs.org/ 
Oregon Historical Society 

1200 SW Park Avenue 
Portland, OR 97205 

(503) 306-5198 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Wasco County Historical Society 
November 2nd. Sunday 11:30 am Barlow Grange Hall. 
The Society holds its annual meeting on the first Sunday 
in November. Members gather for a dinner, a brief 
business meeting and an invited presentation by a County 
historian. 2008 calendar year dues for a family are $25 
(Basic), $40 (Sustaining) or $100 (Patron); dinner cost is 
additional. We invite you to join us.  
 541-298-4065 for reservations. 

 
Holiday Open House Discovery Center 

Enjoy holiday music while the children visit with 
Santa or make crafts.  Free cookies and cider for 
all.  Optional dinner buffet in the     Basalt 
Cafe. December 10th. 5 p.m-8 p.m.   
 For more information, call (541) 296-8600. 

 
Sherman Co. Museum 

December 6th. - Christmas Open House at Sherman Co. 
Museum, Museum store sale, entertainment, Jane 
Kirkpatrick's Book signing 10-4 pm 

http://www.shermanmuseum.org/ 
 

Dufur Hometown Christmas 
December 13th. - Arts & crafts bazaar, 
soup brunch, Christmas wreath sale, 
music, bonfire at the museum, 
pictures with Santa. 
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Pioneer Cemetery Monument Project 
Thank You to the following Contributors  

 
Bob Stone Freeway Auto Center, L. Renee Briggs, 
William Getz & Saundra Buchanan, Elizabeth Wilson 
Buehler, Barbara Love Cady, C.H. Urness Motor 
Company, Lester and Jody Cochenour, Patricia Crimmel, 
Richard and Kathleen Davis, John and Rose Denslinger, 
Lorna Elliott, Calvin and Margaret Gump, Rachel Gunkel, 
Hattenhauer Distributing, Jim Howard, Darrell and Lee 
Klampe, KODL Radio Station, Donald and JoAnn 
Koehler, Jan Leininger, Einar and Phyllis Mohagen, 
Denise Morris, Kevin Price, Richard and Elaine Rife, Julie 
Shepard, Emma Jean Smith, Spencer, Libby, Powell 
Funeral Home, The Dalles Furniture Company, Wasco 
County Historical Society, Wasco County Title Inc., 
Earline Wasser, Sam Woolsey Real Estate, and Leo and 
Joan Zachariasen. 
               

Total in fund to date: $4,327.24 
 
Be sure to personally “Thank” the contributors of the fund 
the next time you see them for their support helping us 
reach our goal! We can not do it without everyone’s help. 
 
 
The Society meets on second Saturday of the month, Sept-
June at 1:00 p.m. at Columbia Gorge Discovery Center, 
5000 Discovery Drive, The Dalles, OR. (unless announced 
otherwise). Officers meeting at 11:00 a.m. No host lunch 
and regular meeting will open at 1:00 p.m. 
 

Membership dues: January to December 
Single & Family $15.00/year. 

 
TALES & TRAILS is published 4 times a year in 
January, April, July and October by the Columbia Gorge 
Genealogical Society.  The 25th of the month preceding 
the publication month is the deadline for submitting items 
to be included in the quarterly. Queries are free to 
members and are $2.00 each to non-members 

 

 
Pioneer Cemetery Donation 

 
NAME:_____________________________ 

 
ADDRESS:__________________________ 

______________________ 
 
STATE__________ZIP________________ 
 
CITY:______________________________ 
 
PHONE:____________________________ 
 
 Mail to:  Columbia Gorge Genealogical Society 
          C/O The Dalles/Wasco Co Public Library 
           722 Court St.       The Dalles, OR 97058 
                                                  
                                    Thank You 
 

 
 

Columbia Gorge Genealogical Society 
New Membership or Renewal 

 

NAME___________________________ 
 
ADDRESS________________________ 
 
_________________________________ 
 
CITY____________________________ 
 
STATE_____________ZIP___________ 
 
PHONE__________________________ 
 
EMAIL__________________________ 
                    Dues are still just $15.00  
Mail to:  Columbia Gorge Genealogical Society 
          C/O The Dalles/Wasco Co Public Library 
           722 Court St.       The Dalles, OR 97058 
 
 



 12 

Columbia Gorge Genealogical Society 
c/o The Dalles/Wasco County Public Library 
722 Court Street 
The Dalles, OR  97058 
http://community.gorge.net/genealogy 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
 

Upcoming Programs 
 

October 11, 2008  -  “Internet Genealogy”  Linda Colton from the  
           LDS History Center in Hood River will present Part 2 of her program.  

                 This class will guide you in your research and organization while 
                  using your  computer to find your ancestors. 

 
             November 8, 2008  -  “Memories in Stone”   Bob and Kris Rising from  
                            Pioneer Rock and Monument in Goldendale will share information 
                            about the interesting headstones and monuments they have helped 
                             to create, and the cemeteries they have worked. 
       
        December 13, 2008 – “Holiday Gathering”   Annual Christmas party.   
                             Members and guests bring in "goodies" and a family heirloom  
                             or a story to show and tell. 
 
 

 
 
 


